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1	 ABOUT THESE INSTRUCTIONS

1.1	 PREFACE

The operating manual contains information about safely operating, installing, maintaining, 
cleaning and repairing the device. The operating manual is part of the device and must be 
available to the operating and service personnel.

The device may only be operated by trained personnel and in compliance with this 
operating manual. Operating and service personnel should be instructed according to the 
safety instructions.

This equipment can be dangerous if it is not operated according to the instructions in this 
operating manual.

1.2	 WARNINGS, NOTICES AND SYMBOLS IN THESE INSTRUCTIONS

Warning instructions in this manual highlight particular dangers to users and to the 
device and state measures for avoiding the hazard. These warning instructions fall into the 
following categories:

DANGER Immediate risk of danger.
Non-observance will result in death or serious injury.

WARNING Potential risk.
Non-observance may result in death or serious injury.

CAUTION Potentially hazardous situation.
Non-observance may result in minor injury.

NOTICE Potentially hazardous situation.
Non-observance may result in damage to property.

Notice Provides information about particular characteristics and how 
to proceed.

Explanation of warning notice:

LEVEL OF DANGER
This notice warns you of a hazard!
Possible consequences of not observing the warning notice.

The measures for preventing the hazard and its consequences.
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1.3	 LANGUAGES

The Layer Check LC 1000 operating manual is available in the following languages:

Language Order no. Language Order no. Language Order no.
German 2395601 English 2395602 Spanish 2395605
French 2395604 Italian 2395606 Chinese 2395607

Additional languages on request or at: www.wagner-group.com

1.4	 ABBREVIATIONS

Order no. Order number
Spare part
Position
Marking in the spare parts lists
Number of pieces

LAN Local area network
SNR Signal to noise ratio
IR Infrared

1.5	 TERMINOLOGY FOR THE PURPOSE OF THIS MANUAL

Personnel qualifications
Trained person Is instructed in the tasks assigned to him/her, the potential risks 

associated with improper behavior as well as the necessary 
protective devices and measures.

Electrically trained 
person

Is instructed by an electrician about the tasks assigned to him/her, 
the potential risks associated with improper behavior as well as 
the necessary protective devices and measures.

Electrician Can assess the work assigned to him/her and detect possible 
hazards based on his/her technical training, knowledge and 
experience in relevant provisions.

Skilled person in 
accordance with 
TRBS 1203  
(2010/Revision 2012)

A person, who, based on his/her technical training, experience 
and recent vocational experience, has sufficient technical 
knowledge in the areas of explosion protection, protection 
from pressure hazards and electric hazards (if applicable) and 
is familiar with the relevant and generally accepted rules of 
technology so that he/she can inspect and assess the status of 
devices and coating systems based on workplace safety.
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2	 CORRECT USE

2.1	 DEVICE TYPE

Non-contact layer thickness measuring device: Layer Check LC 1000

2.2	 TYPE OF USE

The thickness measuring device is suited to the non-contact measurement of layer thicknesses 
for the following coatings: powder lacquers before and after curing, adhesives and liquid 
coatings before and after drying and ceramic coatings on all materials.

– Powder coatings on metallic base
– Adhesive coatings on metallic base
– Polymer coatings on metallic base
– Liquid coating on metallic base
– Liquid coating (when wet) on non-metallic base
– Thermal spray coatings

WAGNER explicitly prohibits any other use!

The device may only be operated under the following conditions:
Do not deactivate safety fixtures.
Use only WAGNER original spare parts and accessories.
The operating personnel must be trained on the basis of this operating manual.
Follow the instructions in the operating manual.
Observe service intervals.

2.3	 FIELD OF APPLICATION

The device is not suitable for use in potentially explosive areas. 
(See Chapter 3.1"CE Identification".)

2.4	 MISUSE

Misuse can lead to physical injury and/or property damage!
Special attention must be paid that:

Do not operate the device in environments where liquids may enter the housing.
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2.5	 WARRANTY CONDITIONS

The warranty conditions form part of the manufacturer's general terms and conditions.

The software is installed on the embedded PC integrated in the Layer Check. Any system 
modifications and modifications to the embedded PC may impair or damage the Layer Check 
and are therefore prohibited. This includes, e.g.,

– Installation of further software
– Software updates

WAGNER assumes no liability for the loss of data on the embedded PC. We would recommend 
regularly backing up data on the embedded PC:

– Saving application data: see Chapter 7.7
– Saving measuring data: see Chapter 7.9
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3	 IDENTIFICATION

3.1	 CE IDENTIFICATION

The device may not be used in potentially explosive areas.

3.2	 TYPE PLATE

J. Wagner GmbH
D-88677 Markdorf
Made in Switzerland

Type: Layer Check LC 1000
Voltage: 220–240 VAC   50/60 Hz
Current max: 10 A
Art. No.: 2364012
Serial No. : P_

03
64

2

3
4
5
6

2

1

Designation
1 Manufacturer and CE symbol
2 Device Type
3 Input voltage
4 Maximum input current
5 Article number
6 Serial number
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4	 BASIC SAFETY INSTRUCTIONS

4.1	 SAFETY INSTRUCTIONS FOR THE OPERATOR

Keep this operating manual at hand near the device at all times.
Always follow local regulations concerning occupational safety and accident prevention.
The operator shall inform the seller without delay of any safety-related events which 
may arise when operating the device or its accessories.
Legal requirements, such as local, state and federal legislation, applicable to the 
device or its accessories, must be strictly observed.

4.1.1	 SAFE HANDLING OF THE DEVICES

Integrated light source!
Direct visual contact may result in visual impairments.

Never look directly into the light source.
When using the Layer Check in the process environment, we would recommend 
building an optical screen around the light source. The screen will absorb the light 
pulse so it has no impact outside the measurement area. Items such as blackened 
plates are suitable for the screen.

False alarm from incompatible fire alarms!
The light pulse from the Layer Check may trigger fire alarm systems.

Only use compatible fire alarms with dual UV/IR sensors in locations where the Layer Check 
is used.
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4.1.2	 ELECTRICAL DEVICES AND EQUIPMENT

Electric shock hazard!
Danger to life from electric shock.

Prepare device in accordance with the local safety requirements with regard to the 
operating mode and ambient influences.
The Layer Check housing must not be opened. Exception: Unscrewing the rear cover 
to clean and/or change the filter mats (see Chapter 9.5).
Only have device maintained by the WAGNER Service Department. 
Exception: Filter mat (see Chapter 9.5).
Operate device in accordance with the safety regulations and electrotechnical regulations.
If water escapes from the Layer Check, you must immediately switch it off with 
the mains switch, disconnect the mains plug and contact the WAGNER Service 
Department.If water escapes from the Layer Check, you must immediately switch 
it off with the mains switch, disconnect the mains plug and contact the WAGNER 
Service Department.
Must be repaired immediately in the event of problems.
Decommission if it poses a hazard or is damaged.
Must be de-energized before work is commenced. Inform personnel about planned work. 
Observe electrical safety regulations.
Ground all devices to a common grounding point.
Only operate the device with a properly installed socket with a protective ground wire 
connection.
In order to interrupt the power supply in an emergency by disconnecting the mains 
plug, no devices or other objects may be blocking access to the mains plug.
Keep liquids away from electrical devices.

4.1.3	 PERSONNEL QUALIFICATIONS

Hazard due to incorrect use of device!
Risk of death due to untrained personnel.

Ensure that the operating personnel has been instructed by the operator in accordance 
with the operating manual and the operating instructions. The device may only be 
operated by trained staff. Refer to the operating instructions for information about 
the required personnel qualifications.
Ensure that the operating staff have read and understood the operating manual.
The device may only be used by people who have the training or professional 
experience to enable them to understand the risks which may arise when operating 
the device.
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4.2	 SAFETY INSTRUCTIONS FOR THE PERSONNEL

Always follow the information in this manual, particularly the safety instructions and 
the warning instructions.
Always follow local regulations concerning occupational safety and accident prevention.

4.2.1	 SAFE HANDLING OF THE DEVICES

Integrated light source!
Direct visual contact may result in visual impairments.

Never look directly into the light source.

4.2.2	 GROUNDING THE UNIT

Electric shock!
Danger to life.

Before use check that grounding is correct.
Immediately replace any defective cables.

4.2.3	 MAINTENANCE AND REPAIR

Hazard due to improper maintenance and repair!
Danger to life and equipment damage.

Only a WAGNER service center may carry out repairs and replace parts. 
Exception: Filter mat.
Do not change or modify the device; if change is necessary, contact WAGNER.
Only repair and replace parts that are listed in the 12 chapter that are assigned to 
the unit.
Do not use any defective components.
Before all work on the device and in the event of work interruptions:
– Shut down power supply.
Observe the operating and service manual for all work.

4.2.4	 PROTECTIVE AND MONITORING EQUIPMENT

Hazard due to removal of protective and monitoring equipment!
Danger to life and equipment damage.

Protective and monitoring equipment must not be removed, modified or rendered 
unusable.
Regularly check for perfect functioning.
If defects are detected on protective and monitoring equipment, the device must not 
be operated until these defects are remedied.
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5	 DESCRIPTION

5.1	 COMPONENTS

P_03487

LC 1000 operating elements
See Chapter 5.6.

5.2	 MODE OF OPERATION

The Layer Check operates on the principle of the 
thermal layer check. A light pulse heats the surface 
of the coating. After it has been briefly heated by 
a few degrees Celsius, the surface is cooled by 
dissipating heat into the lower parts of the coating 
and base. The manner in which the surface cools 
depends on the physical properties of the coating and 
base. If the coating has a lower thermal conductivity 
than the base, the thinner the coating is, the faster 
the surface temperature then subsides.

P_03495

IR sensor IR radiation

Flash lamp
Heat input in 
pulses

Ba
se

Co
at

in
gs
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5.3	 PROTECTIVE AND MONITORING EQUIPMENT

WARNING
Protective and monitoring equipment!
Risk of injury and damage to the device.

Protective and monitoring equipment must not be removed, modified or rendered 
unusable.
Regularly check for perfect functioning.
If defects are detected on protective and monitoring equipment, the system must 
not be operated until these defects are remedied.

Optical screen
When using the Layer Check in the process environment, we would recommend building 
an optical screen around the light source. The screen will absorb the light pulse so it has 
no impact outside the measurement area. Items such as blackened plates are suitable for 
the screen.

5.4	 INCLUDED ITEMS

Designation Order no.
Layer Check LC 1000:
– Layer Check measuring device
– Mains cable

--

The scope of delivery includes:
Service log book Layer Check LC 1000 --
Declaration of Conformity. For details, see Chapter 13 2395608
Operating manual for Layer Check, in German 2395601
Operating manual in the local language see Chapter 1.3

The delivery note shows the exact scope of delivery.

Note:
The Layer Check LC 1000 is available with monitor/PC, light barrier and lifting carriage (option):
Layer Check LC 1000 Standalone 

(with lifting carriage)
Set 

(without lifting carriage)
Designation Order no. Order no.
Layer Check LC 1000 2388371 2392757
Consists of:

– Layer Check measuring device ✓ ✓

– Mains cable ✓ ✓

– Layer Check gateway (PC) ✓ ✓

– Connection kit ✓ ✓

– Grounding cable ✓ ✓

– 15.6" IP65 display + support arm + USB ✓ ✓

– Lifting carriage ✓

– Light barrier ✓ ✓
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5.5	 TECHNICAL DATA

Description LC 1000
Power supply 1000 J
Measuring distance* 5–30 cm; 2.0–11.8 inch
Measuring point** Ø 2–20 mm; 0.08–0.8 inch
Measuring range:

Powder lacquer not cured 1–500 µm
Powder lacquer cured 1–1000 µm
Powder lacquer started to gel 1–1000 µm
Liquid coating 1–1000 µm

Duration of measurement 20–2000 ms
Frequency with which measurement is repeated 0.5 Hz
Relative measurement object movement 50 m/min
Angle tolerance ±70°
Power connection IEC 320-C14
Rated voltage 230 V AC, 50 Hz
Maximum power consumption 2000 W
Operating temperature 5–35 °C; 41–95 °F
Relative humidity < 80 %

Dimensions 374 × 490 × 196 mm
14.7 × 19.3 × 7.7 inch

Weight 16.8 kg; 37 lb
Mount Guide rail

Interfaces
Ethernet

External sensor
WLAN optional

* depending on coating and substrate
** depending on distance / focal width
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5.6	 OPERATING ELEMENTS AND DIMENSIONS

Front side Profile

P_03488

A

B

C

D

E

F

G

H

Measurement mm inch
A 374 14.72
B Ø 120 Ø 4.72
C Ø 47 Ø 1.85
D 102 4.02

Measurement mm inch
E 295 11.61
F 196 7.72
G 471 18.54
H 380 14.96

P_03480

2

1

3

4

5

Rear side♠
Function

1 On/off switch
2 Power connection
3 USB connection for WiFi
4 Ethernet connection
5 Sensor connection
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6	 ASSEMBLY AND COMMISSIONING

6.1	 TRAINING OF ASSEMBLY/COMMISSIONING PERSONNEL

The assembly and commissioning personnel must have the technical skills to safely 
commission the device.
When assembling, commissioning and carrying out all work, read and follow the operating 
manuals and safety regulations for the additionally required system components.

A skilled person must check to ensure that the device is in a reliable state after it is installed 
and commissioned.

6.2	 STORAGE CONDITIONS

Under certain circumstances, there will be information on the packages relating to storage 
and putting back into storage, which is more exacting than the requirements stated here. 
Observe this information accordingly.
Store packages under the following conditions:

– Do not keep outdoors.
– Store in a dry location free of dust.
– Do not subject packages to aggressive substances.
– Protect from sunlight.
– Avoid mechanical impact and vibrations.
– Storage temperature: 5–35 °C; 41–95 °F

Before switching on, wait until the device has reached room temperature.
– Relative humidity: max. 80 %

If storing for more than 3 months:
– Regularly check the general condition of all parts and the packaging.
– If necessary, refresh or renew the anti-corrosion protection.
– Start up Layer Check at least every six months.

6.3	 TRANSPORT INSPECTION

Upon receipt, immediately check that the delivery is complete and has not incurred damage 
during transport. If any damage incurred during transport can be seen externally, proceed 
as follows:

– Do not accept delivery or only do so with reservations.
– Note the extent of damage on the transport documents or on the shipping company's 

delivery note.
– Initiate the complaints process.

Raise a complaint about any damage as soon as it is detected. Claims for compensation for 
damages can only be made within the claim periods.

6.4	 ASSEMBLY AND INSTALLATION

Check the Layer Check's components against the delivery note. Keep original packaging 
for future use. Read the operating manual.
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6.4.1	 INSTALLATION AND CONNECTING TO THE MAINS

– Install the device on a clean, sturdy, flat and horizontal surface.
– Do not place any objects on or under the device.
– The device must be located at a distance of at least 20 cm; 7.9 inch from the nearest 

object or wall to ensure sufficient cooling.
– Use the mains cable supplied to connect the device to the mains.

WARNING
Electric shock!
Danger to life.

Before use check that grounding is correct.
Immediately replace any defective cables.

CAUTION
Integrated light source!
Direct visual contact may result in visual impairments.

Never look directly into the light source.
When using the Layer Check in the process environment, we would recommend 
building an optical screen around the light source. The screen will absorb the light 
pulse so it has no impact outside the measurement area. Items such as blackened 
plates are suitable for the screen.

Note:
In order to interrupt the power supply in an emergency by disconnecting the mains 
plug, no devices or other objects may be blocking access to the mains plug.

NOTICE
False alarm from incompatible fire alarms!
The light pulse from the Layer Check may trigger fire alarm systems.

Only use compatible fire alarms with dual UV/IR sensors 
(e.g., those from STS Brandschutzsysteme GmbH) in locations where the Layer Check is used.

NOTICE

 90
° 

P_03643

 90° 

P_03644

Devices installed at too great an inclination!
Device overheats.

If the device is installed vertically tilted, do not 
exceed an angle of 90°. If the device is installed 
horizontally tilted, do not exceed an angle of 90°.
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NOTICE
Fingerprints and dirt on the lens!
Measurement errors and device faults.

Never touch the lens directly.
Clean lens and measurement window according to Chapter 9.4.

6.4.2	 ASSEMBLY OF ADDITIONAL COMPONENTS (EXAMPLE)

6.4.2.1	 ASSEMBLY ON LIFTING CARRIAGE

Follow the instructions in the lifting carriage operating manual at all times!

P_03640

E

A
B
C
D

F

G

1. Position lifting carriage somewhere level, solid and smooth.
2. Secure lifting carriage's wheels.
3. Use hand crank (E) to move retaining fixture (C) of lifting carriage (G) to a suitable 

height.
4. Position measuring device (A) on retaining fixture (C). Do not touch lens (B)!
5. Use 4 screws and washers to screw 

underside of measuring device (A) onto 
retaining fixture (C).

P_03638P_03639

6. Plug Ethernet cable into measuring device (A).
7. Plug light barrier cable into measuring device (A) (connection for external sensor).
8. Plug mains cable into measuring device (A).

6.4.2.2	 MONITOR ASSEMBLY

Follow the instructions in the monitor operating manual at all 
times!

P_03641

D

H

Switch off voltage supply.
1. Fit monitor holder (H) on lifting carriage (G). The long tube section 

must be at the top.
2. Fit monitor (D) on monitor holder (H).
3. Install monitor (D) according to monitor operating manual.

6.4.2.3	 GATEWAY ASSEMBLY

Follow the instructions in the gateway (embedded PC) operating manual at all times!
Switch off voltage supply.

1. Install gateway according to gateway operating manual.
2. Connect gateway with monitor.
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6.4.2.4	 LIGHT BARRIER ASSEMBLY

Follow the instructions in the light barrier operating manual at all times!
Switch off voltage supply.

1. Install light barrier according to light barrier operating manual.
2. Connect light barrier with measuring device in accordance with Chapter 7.3.2.1.

6.5	 SOFTWARE ENVIRONMENTS

The Layer Check can be operated with three different software environments:

Layer Check desktop client
Triggering measurements, creating applications, exporting measurement data, displaying 
measured values and statistics. Applications can only be created and measurement data 
can only be exported with the Layer Check desktop. The software must be installed on a 
Windows PC. System requirements:System requirements:

– Operating system: Windows 10, 64-bit
– Processor: 2.4 GHz
– RAM: 4 GB
– Available hard disk space: 300 MB
– Screen resolution: 1024 x 768

Layer Check web client
Triggering measurements, displaying measured values, setting network and administrator 
settings, installing software updates. Network and administrator settings can only be set and 
software updates can only be installed with the web client. System requirements:

– Web browser

Remote control
Measurement via the TCP/IP interface. This interface can be used to trigger measurements 
and transfer measured values. Examples: PLC systems such as Siemens S7 or Beckhoff TwinCAT.

For measurements using the web client or remote control, a suitable application must 
first be created with the Layer Check desktop client. This is described in Chapter 7.5.1 
and 7.6.3.

6.6	 CONNECTING WITH THE PC

In order to operate the Layer Check, the PC must be connected with the Layer Check via an 
Ethernet cable.
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6.7	 NETWORK AND ADMINISTRATOR SETTINGS

1. Ensure that the Layer Check is correctly installed in accordance with the instructions 
in Chapters 6.4 to 6.6.

2. Switch on device.
3. Configure Layer Check network access in accordance with Chapter 6.7.1.
4. Install Layer Check desktop client on at least one Windows PC in accordance with 

Chapter 6.7.2. The Layer Check desktop client is needed to create Layer Check applications.

6.7.1	 CONFIGURING THE LAYER CHECK NETWORK ACCESS

The IP address of the Layer Check (e.g., "192.168.1.140") can be found in the service log book. 
The service log book is part of the scope of delivery. If the network configuration 
(IP address, network mask, gateway) is to be changed, proceed as follows:

1. Ensure that the Layer Check and Windows PC are connected using an Ethernet cable.
2. Open a web browser. Enter the IP address of the Layer Check in the URL field and confirm 

with "Enter".
Factory setting upon delivery: The IP address of the Layer Check can be found in the 
service log book. The service log book is part of the scope of delivery.

3. The web browser now connects to the Layer Check and opens the main window of 
the Layer Check web client.

P_03485

A

B

4. If necessary, change the language with the button at the top right (A):

5. Click on "Administrator" (B).
Log on as the user "admin" with the password "Welcome123".
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6. The IP address for the Ethernet connection can be defined in the network window (C). 
Notice: The sub-network addresses 192.168.139.XXX and 109.198.7.7.XXX are not permitted.

P_03486

C

Take a note of the data so that you have it for use later on:

Layer Check serial number

IP address

Should you lose the access data, please inform your administrator.

7. Save network settings.
8. After any changes to the network settings, restart the Layer Check: 

Switch off main switch, wait 10 seconds, switch main switch on again.
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6.7.2	 INSTALLING THE LAYER CHECK DESKTOP CLIENT

1. Ensure that the Layer Check and Windows PC are connected using an Ethernet cable.
2. Open a web browser. Enter the IP address of the Layer Check set in Chapter 6.7.1 

(e.g., "192.168.1.116") in the URL field and confirm with "Enter".
3. The web browser now connects to the Layer Check and opens the main window of 

the Layer Check web client.

P_03485

A

B

4. If necessary, change the language with the button at the top right:

5. Click on "Downloads".
The Download sub-menu appears:

P_03492

xxxxxx.Operating.System.XX.X.xxxxxx

6. Download Layer Check desktop client:
Click on "xxxxxx.Operating.System.XX.X.xxxxxx".

7. Unzip the downloaded ZIP file.
Notice: Depending on web browser, you will find the downloaded file using "Show 
all downloads" or similar.

8. The folder of extracted files contains the Layer Check desktop client "Layer Check 
Operating System XX.X.exe".
Notice: To simplify access to the desktop client, create a link on the desktop.

9. Launch the Layer Check desktop client with a double click.
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10. Go to: Configuration > Settings > Server

P_03493

11. Enter the Layer Check IP address in the "Host or IP address" field (see Chapter 6.7.1).
12. Ensure that the connection can be established: Click on "Test server connection".

If the test fails: Ensure that the PC and Layer Check are connected using an Ethernet cable. 
Check IP address and Ethernet connectivity.

To change the Ethernet IP address, proceed according to Chapter  6.7.1.

6.7.3	 CHANGE LANGUAGE

1. Configuration > Language
A sub-menu containing the languages available appears.

2. Click on the desired language.
3. Confirm the program restart by clicking on OK.

The program now opens in the selected language.
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6.7.4	 ADMINISTRATOR SETTINGS

1. Configuration > Settings > Administrator

P_03494

2. Log on.
Administrator password: admino041 > OK.
The "Edit/delete application" field is activated.

3. Checking/removing the check from the checkbox permits/prohibits the editing and 
deleting of applications. The function relates to creating a new application, deleting, 
copying, renaming and editing an existing application and deleting measuring points 
in the trend.
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7	 OPERATION

7.1	 TRAINING THE OPERATING PERSONNEL

The operating personnel must be qualified to operate the entire system.

The operating personnel must be familiar with the potential risks associated with improper 
behavior as well as the necessary protective devices and measures.
Before work commences, the operating personnel must receive appropriate system training.

7.2	 LAYER CHECK USE FOR ROUGH SURFACES

For rough surfaces, we recommend using a reference method, such as weighing or several 
microscopic cross-section measurements, to compensate for major variations in the thickness 
results from cross-section analyses. In a reference method with contact (e.g., electromagnetic 
or micrometer probes), the surface roughness dramatically reduces the reproducibility of 
thickness measurements. A large Layer Check measuring point reduces the dependency of 
incorrect ink particle placements.
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7.3	 MEASURING WITH THE DESKTOP CLIENT

The Layer Check desktop client must be installed on a Windows PC in order to create applications 
and take manual and automated measurements.

1. Switch on Layer Check.
2. After one minute, connect PC and Layer Check via the Ethernet. This can be done either 

via a direct connection with a cable or by integrating the Layer Check into the local 
network.

3. Launch Layer Check desktop client.
The main window appears:

P_03496

A

B

C D

E

F

Designation
A Menu
B Applications.

Application name grayed out = application is not yet complete and requires 
further user input.

C Measurement
D Statistics
E Trend (set limits for warning and error ranges: see Chapter 7.5.2)
F Status bar

Notice: Restore main window: In menu (A): Window > Reset window.
4. On the right, the status bar (F) shows whether the Layer Check desktop client is connected 

to the Layer Check.
5. Carry out measurements:

– Select desired application (B).
If a suitable application is not yet available, create application in accordance with 
Chapter 7.5.1.
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7.3.1	 MANUAL MEASUREMENT

Trigger measurement manually:

P_03497

C

G

1. In the Measurement area (C) of the 
main window, click on button (G).

2. The result of the measurement is 
displayed in the defined units 
(e.g., µm).

Statistics
The "Statistics" area (D) contains statistical parameters, such as average value, standard 
deviation etc., which are calculated across all measurements in the block currently selected.

Blocks
Blocks are user-defined collections of measurements. If taking measurements at several 
points, you can use one new block for each measurement position, for example, to display 
the average value at each position. Each application is created with the "Default" block.

Create new block:

New measurements are saved in the block currently selected.

Trend
The last measured values for a block are displayed in the Trend area (E). They are arranged 
by the measurement time. Trends, such as a systematic increase or decrease in the layer 
thickness, can be seen in this area. To increase the resolution, a zoom window can be 
drawn with the mouse. Individual data points can be deleted with a right click.

Functions in the Measurement area (C)

Start measurementStart measurement

Add block

Managing Blocks

Export measurements (just as with File > Export)

Automatic operation
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7.3.1.1	 MANAGING BLOCKS

A block is a collection of measured values.
Naming, deleting and exporting blocks

1.

P_03498

2. Highlight the desired block.
3. – Delete: Deletes the block.

– Block export: Exports the block's measured values from the Layer Check on your PC. 
For more information about exporting data: See Chapter 7.9.

4. – OK: Saves the settings and closes the window.
– Cancel: Closes the window without saving.

7.3.2	 AUTOMATED MEASUREMENT WITH EXTERNAL SENSOR

In automatic mode, the measurement is triggered by an external sensor. The sensor must 
be connected to the Layer Check as described below. This function permits an automated 
measurement, e.g., in a production line. As soon as a part is detected by the sensor, a series 
of measurements can be triggered.

The measured values are saved on the Layer Check. There are three ways of displaying the 
measured values generated:

– Display measured values live in the desktop client (see Chapter 7.3.2).
– Display web client measured values live on a WLAN-compatible display (e.g., tablet or 

monitor) see Chapter 7.4.2).
– Use the desktop client to export measured values to the PC. Process measured values 

further with other software (e.g., Excel) (see Chapter 7.9).

7.3.2.1	 CONNECTING EXTERNAL SENSOR

The external sensor is connected to the Layer Check via a standard 15 V interface with an 
XLR connector.
The sensor connection has the following pin assignment:
XLR connector for external sensor

Designation
1 GND
2 +15 V supply
3 Signal

P_03499

1

2
3
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7.3.2.2	 STARTING AND STOPPING AUTOMATIC MEASUREMENT

1. Switch to automatic mode in the header of the measuring range, in the main window:

The automatic view appears:

P_03600

A

B

C D

2. Select automatic configuration (A)
3. Select measurement application (B)
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4. Start automatic measurement (C)
The active automatic view appears:

P_03601

D

F

G

E

5. The Trend area (F) displays the measurements.
The Status line (G) displays the sensor status: Sensor signal request (polling) or 
measurement.

6. Stop automatic measurement (E)
7. If necessary, take further automatic measurements: Repeat steps 2–6.
8. Close automatic view (D)

Functions in the automatic view

Start automatic measurement

Stop automatic measurement

Close automatic view
(Back to main window in Chapter 7.3)

 

(orange) Warning symbol (appears next to the measured value).
Significant deviation in measured value.

(red) Error symbol (appears next to the measured value).
Too great a deviation in measured value.
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7.3.2.3	 AUTOMATIC CONFIGURATION

1. – Creating new automatic configuration
In the automatic view (Chapter 7.3.2.2) in the "Configurations" window: 

– Changing existing automatic configuration
Right-click on configuration name > Change configuration

2. Define settings:

P_03602

A
B
C
D
E
F
G

A Name of automatic configuration
B Polling frequency of sensor signal (ms): Frequency of sensor signal request 

(polling interval). Reduce the value for quick-moving objects. Example: An object 
with a speed of 40 m/min, moves 3.3 cm in 50 ms. If the measurement spot is 
to be positioned with greater accuracy, the polling interval must be shortened 
accordingly.

C Wait time before measurement (ms): Delay between trigger signal and first 
measurement (ms).

D Wait time between two measurements (ms): Wait time between individual 
measurements on the same object.

E Number of measurements after trigger signal: Number of consecutive 
measurements on the same object.

F Timeout during measurement (ms): If the duration of the measurement exceeds 
this time, the measurement is aborted.

G Measurement after every nth trigger signal: Measurement is triggered every n 
trigger signals. If a number greater than one is set, objects detected by the sensor 
are jumped. For example, the value "3" only triggers measurements for every 
third object (jumps two objects).

3. Save the settings: OK
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7.3.3	 MEASUREMENT STATISTICS

The statistics area of the main menu (see Chapter  7.3) contains statistical information 
about the measurement data for the block currently selected.

Example of a statistical analysis of block data

P_03603

A
B
C
D

E

F
G

Meaning
A Average value
B Standard deviation
C Minimum value in data block
D Maximum value in data block
E Number of measurements in data block

F Number of measurements below the lower tolerance 
limit

G Number of measurements above the upper tolerance 
limit

If the block is changed, the statistics window is updated with the values for the newly selected 
block.
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7.3.4	 WARNINGS AND ERRORS

In the measurement area of the main window (see Chapter 7.3), the following warning and 
error symbols may appear:

Symbol Meaning

(orange)
Measurement warning
Potential deviation between current measurement and 
application data.

(red)
Measurement error
Major deviation between current measurement and 
application data.

(orange)

Measurement warning range
Indicates that a user-defined number of consecutive 
measured values are in the warning range. 
For settings, see Chapter 7.5.2.1.

(red)

Measurement error range
Indicates that a user-defined number of consecutive 
measured values are in the error warning range. 
For settings, see Chapter 7.5.2.1.

(orange)

Maintenance imminent notice
Device maintenance is due shortly. Inform the WAGNER 
Service Department to organize the maintenance cycle. 
Have data from "Help > About this Layer Check" to hand 
(see Chapter 7.3.5).

(red)

Maintenance due notice
Device maintenance is due. Operating the device without 
maintenance shortens its service life, reduces accuracy 
and increases the risk of sudden failure. Inform the 
WAGNER Service Department to organize the maintenance 
immediately. Have data from "Help > About this Layer Check" 
to hand (see Chapter 7.3.5).
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7.3.5	 SYSTEM AND MAINTENANCE INFORMATION

Displaying software version and hardware status
In the main window (see Chapter 7.3): Help > About this Layer Check

Layer Check

Layer Check 
    
    

Layer Check 
    
    

    
    

Status light source
100 % = new light source
0 % = Replace light source and carry out 
maintenance.

Next service in
Maximum number of days until next 
maintenance is due.

Maintenance must be carried out by the 
WAGNER Service Department:

– When the light source has reached 0 %.
– 364 days after the last maintenance at the 

latest.

Operating the device without maintenance 
shortens its service life, reduces accuracy and 
increases the risk of sudden failure. Contact 
the WAGNER Service Department to organize 
the maintenance cycle.
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7.3.6	 CONFIGURING LAYOUT OF MAIN WINDOW

Optional information
Display optional information in the main window (see Chapter 7.3):

P_03604

1. Window > View
2. Click on the desired view > OK

View Information displayed
Actual Last measured value
Automation 
Log

Log of all automation control data

Data Chart Measurement signals as time curves
Curves of the signal for the photodiode 
and thermal signal for a measurement

Data Measurement signals in numerical table 
form

Device Log Only for service mode
State See Chapter 7.3.6.1
Test To run a device test, e.g., a defined number 

of subsequent measurements.
Workspace Only for service mode

Restoring default setting
1. Window > Reset window

The Applications, Measurement, Statistics and Trend windows of the selected 
application are displayed (see Chapter 7.3).

Statistics, Trend and Data Chart windows
Right-clicking on the diagram opens a sub-menu containing the following options:

– Define properties of diagram
– Save or print out diagram
– Zoom in and out
– Define auto range
– Export diagram and remove

7.3.6.1	 STATE

The Status window shows the current temperature, flow and coolant 
level.

P_03605

Threshold value for warnings:
– Temperature: 40 °C
– Coolant flow: 2 l/min
– Coolant level: 20 %

Threshold value for errors (measurement no longer possible):
– Temperature: 60 °C
– Coolant flow: 1 l/min
– Coolant level: 10 %
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7.4	 WEB CLIENT

1. Connect PC with Layer Check. Launch web client software as described in Chapter 6.7.1. 
The following screen appears:

P_03485

A

B

2. Measure: Carry out the measurement.  See Chapter 7.4.1.
Monitor: Display measured values from measurements with external trigger. 

See Chapter 7.4.2.
Settings: See Chapter 7.4.3.
Administrator: See Chapter 6.7.1.
Downloads: See Chapter 6.7.2.

7.4.1	 MEASURINGINSTRUMENTS

1. Click on "Measure" in the web client (see Chapter 7.4).
A list of all saved applications appears:

P_03606

2. Select application you want to use for the measurement. If the corresponding application 
is not available, it first has to be created (see Chapter 7.5.1).

P_03607

3. Click on "Start Measurement".
Measurement diagram: For explanation, see Chapter 7.4.2
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7.4.2	 MONITOR

Display measured values from measurements with external trigger (either sensor or remote 
control software):

1. Click on "Monitor" in the web client (see Chapter 7.4).
A list of all saved applications appears:

P_03608

2. Select application you want to monitor.
3. Click on "Start".

If the Layer Check is running in automatic mode or measurements are being triggered 
via the remote control software, progress of the measurement can be monitored 
continuously.

P_03609

B

A

C

D

D

E

F

G

The measured value is displayed in the selected unit (A).
The measured value is entered in the diagram (B).
The gray area in the diagram indicates the tolerance range (C).
The red areas above and below mark the limits of the tolerance range (D). The tolerance 
range is defined in the application.
The black line of dots in the center shows the average value (E).
To the right above the curve diagram, you will find (F):

– Average value
– Standard deviation
– Number of measurements carried out

The trend is deleted by clicking on Reset (G).
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7.4.3	 SETTINGS

1. Click on "Settings" in the web client (see Chapter 7.4).
The settings window appears:

P_03610

A

C

B

D

2. Adjust settings for depicting measurement trends with the Layer Check web client:
– Number of stored measurements (A): Number of measurements taken most recently, 

which are stored on the device.
– Number of visible measurements (B): Number of measurements taken most recently, 

which are displayed in the trend.
– Labeling x-axis (C): Time of the measurement or index of the measurement.
– Calculate average value and standard deviation over the last n values (D):

Number of values measured most recently which are to be used to calculate the 
average value and standard deviation.

3. Save settings: Save
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7.5	 LAYER CHECK APPLICATIONS

Calibration using reference measurements
Coating processes are specified by an upper and lower layer thickness limit value 
(tolerance range). At least one sample with one coating at the lower limit and one sample 
at the upper limit of the tolerance window should be used for the calibration process. 
2–4 measurements are taken on each of these reference samples with the Layer Check. 
The measuring points should be marked so that the layer thickness can be measured at the 
same points later on using a reference process.
For optimum results, calibration should use the same materials and parts that are to be 
used later in the process. The Layer Check does however tolerate some deviations between 
calibration and measurement, as follows:

– Calibration on metal substrate and measurement on substrate with slightly differing 
alloy combinations (e.g., different steel grades).

– Calibration on thin plates, measurement on thick plates or vice versa. 
(Tick "Variation in substrate properties" checkbox in the software).

– Calibration on level surfaces, measurement on curved surfaces.
– Depending on coating and substrate material, a certain temperature fluctuation is 

acceptable.

The following factors affect the Layer Check measurement. The same conditions should be 
met during calibration and measurement:

– Surface roughness. If the measurements are being taken on rough surfaces, the 
calibration should also be undertaken on rough surfaces.

– Coating area. If the coatings are only on a narrow area or areas which are not linked, 
the calibration should also be carried out on the reduced area.

– Substrate material. If the same coating is being measured on various substrate materials 
(e.g., on metal and plastic or on aluminum and steel), a new Layer Check application 
should be created for each substrate material.

Wherever possible, the reference samples should be kept. These can be used to check the 
long-term stability of the Layer Check.

7.5.1	 CREATING NEW LAYER CHECK APPLICATION

This function is only available in the Layer Check desktop client.
Creating application for measurements before curing: See Chapter 7.6.3

1. Produce reference samples and keep ready for the calibration process.
2. Switch on Layer Check and launch desktop client.
3. Click on the "New application..." button in the Applications area (Chapter 7.3).

If this button is grayed out, the administrator has blocked this function for the user (factory setting). 
Releasing function: See Chapter 6.7.4.

The following window appears:
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P_03611

A

C

B

D

E

4. – Name (A): Give the new application a name.
– Coating (B): Select the most suitable coating material from the drop-down menu. If there is no suitable 

material available, select "unknown".
Use the fields for the upper and lower limit (μm) to define the tolerance range for the coating.

– Substrate material (C): Select the most suitable substrate material from the drop-down menu.
Use the fields for the upper and lower limit (μm) to define the tolerance range for the substrate.

– Calibration method (D):
a. Reference measurement = calibration using a measurement.
b. Material database = calibration using the existing material database for the Layer Check. No further 

steps are needed for the new application and it can be created by clicking on "Finish". Calibration 
uses the material properties saved in the material database. Our database is continually being added 
to and updated. Coating materials differing from the standard materials stored in the database may 
however produce errors in the measured values. For more accurate results, use calibration based on 
reference measurements.

– Option (E): Initially leave the "Thickness Offset (layer thickness)" option with no check in the box.
Further information about the correlation between Layer Check measurements and reference 
measurements is needed when deciding whether to use this option or not. This information is available 
once the calibration has been carried out (see Chapter 7.5.3.1).

5. Click on "Next" (F).
Continue with Chapter 7.5.2.



43

OPERATING MANUAL

VERSION 03/2018 ORDER NUMBER DOC 2395602
Layer Check

7.5.2	 REFERENCE MEASUREMENT

P_03612

A
C

E

B

D

F

1. Position measurement object in front of the Layer Check measurement window.
2. Click on "Add…" (A).

Alternatively, the measurement can be triggered by an external sensor or using a TCP 
command: This function can be activated with "External" (B).

Add at least one reference measurement for each reference sample.
3. For each Layer Check reference measurement, click in the corresponding reference 

value field (C) and enter the reference value for the layer thickness.
The reference value is often determined by electro-magnetic hand-held measurement 
devices or microscopic cross-section analyses.
For the processing of coatings before curing, see Chapter 7.6.
If not all reference values for all Layer Check reference measurements are entered, 
you will not yet be able to continue with the calibration. However, the application 
can be saved using the "Save" button (D). A saved application can be edited and 
the reference values can be entered at a later point.

4. Once all reference values are present, the calibration algorithm can be started: 
Click on "Next" (E).
The results of calibration are displayed in the calibration report (see Chapter 7.5.3).

Further parameters can be configured for each application (F). These parameters control how 
the measured values (Chapter 7.5.2.1), light energy and measurement time (Chapter 7.5.2.2) 
and measurement evaluation (Chapter 7.5.2.3 and 7.5.2.4) are displayed.
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7.5.2.1	 DISPLAY

This tab contains more settings for displaying the measured values.

P_03613

A

C

B

D

E

G
F

Decimal places for coating thickness (A): Number of decimal places to be displayed for the 
coating thickness display.

Definition of tolerance, warning and error ranges
The diagram in the Trend area of the main window (see 
Chapter  7.3) can be split into three areas: Tolerance (gray), 
warning (pale orange) and error (dark orange). If a certain 
number of consecutive measurements are above the warning 
limit, the measurement warning range symbol appears in 
the measurement area. If a certain number of consecutive 
measurements are above the error limit, the measurement 
error range symbol appears in the measurement area.

Measurement warning 
range

(orange)

Measurement error 
range

(red)

Tolerance (B): Upper and lower tolerance limit for coating thickness (gray area in Trend area).

No. of measurements until warning (C): Number of consecutive measurements in warning 
range after which the measurement warning range symbol is to be triggered.

Error (D): Lower and upper limit between warning and error range for coating thickness.
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No. of measurements until error (C): Number of consecutive measurements in error range 
after which the measurement error range symbol is to be triggered.

Requires confirmation (F): In the event of an error, an error message appears. This has to 
be acknowledged by the user before the measurement can continue.

Range (G): Lower and upper display range for the diagram in the Trend area.

Example of tolerance, warning and error ranges in the Trend area, depending on settings 
under the Display of user settings tab:

P_03614

The settings for tolerance range, units and decimal places only affect the on-screen 
display and have no impact on how the measured values are calculated.

Save: Saves the new application, adds it to the list of applications and closes the dialog.

Cancel: Closes the window without saving.
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7.5.2.2	 DEVICEDEVICE

P_03615

A

B

C

Measurement duration [ms] (A): Duration of the dynamic surface temperature measurement. 
The field contains a proposed value, which is determined by the choice of coating material 
and coating thickness range.

Light energy [J] (B): Energy level of light flash. This option is only available if no reference 
measurements are saved in the application! Increase this value to increase the SNR, for 
improved repeatability or to increase the distance between lacquer surface and Layer Check. 
Too low an SNR may result in failed calibration.

SNR threshold value (C): Measurements with a SNR (signal to noise ratio) below this 
threshold are discarded. Set the SNR threshold value to a value, which is below the 
SNR value stated in the calibration report. If the SNR threshold value is too high, valid 
measurements are discarded. If the SNR threshold value is too low, invalid measurements 
are not discarded.
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7.5.2.3	 EVALUATION

P_03616

A

B
C

D

Substrate properties (A):
"Allow variation of substrate properties": This option should be selected if you want to 
perform the calibration and measurement on substrates of different thicknesses (e.g., thin 
and thicker sheet metals).

However, for optimum results we always recommend performing the calibration and 
measurement under conditions that are as similar as possible.

Allow variation of surface properties (B): This option should be selected if the roughness 
of the coating may change (with semi-transparent coatings) or the substrate gleams (with very 
thin layers). This setting may improve the quality of measurements if calibration fails.

Force correlation with reference (C): This option should be selected if there is a poor 
thermal contrast between the layer and substrate, i.e., they have virtually identical properties. 
The measured values may then vary greatly and the setting has a stabilizing effect.

Warning [%] and Error [%] (D)
Threshold value as of which a warning or error is displayed 
if the measured value deviates too far from the application 
used. The measurement warning/measurement error symbol 
appears in the Measurement area of the main window.
The specified settings are a suggestion based on the measurement 
data previously recorded with this application.

Measurement warning

(orange)

Measurement error

(red)
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7.5.2.4	 LIMITS

Upper and lower parameter limits for coating (A) and substrate (B)
Do not change limits unless you are an expert in this field!

P_03617

G
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D
E
F

C
D
E
F

Layer time constant (C): Time the heat needs to penetrate the layer.

Optical constant (D): States how far down the light/heat penetrates into the coating, i.e., how 
good the coating's absorption properties are.

Effusivity contrast (E): States the size of the thermal difference between the coating and 
substrate.

Contact resistance (F): States whether the heat has to overcome a barrier at the layer transition 
between the coatings or between the coating and substrate.

Gain (G): States the distance between the Layer Check and sample, i.e., how well the heat is 
absorbed and emitted again.
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7.5.3	 CALIBRATION REPORT

Once the calibration process is complete, the result is shown in a calibration report.

P_03618

D

A

B

C

The calibration algorithm determines whether the correlation between the Layer Check 
and reference measurements is good and whether the Layer Check measurements are reliable.

Mean deviation (A)

> 25 % There is too great a deviation between Layer Check and reference 
measurements.

10–25 % Match is sub-optimum.
< 10 % Match is acceptable.

Ways of reducing the mean deviation
– There is possibly an outlier or poor reference measurement. This is the case if the 

points in the correlation graph (D) are generally in a straight line with the exception of 
one point. In this case, move the outlying point in the list of measurement references 
by clicking on the "<Back" button.

– It is possible that the Layer Check measurements are incorrect. Repeat all Layer Check 
reference measurements.

– If the points in the correlation graph (D) are in a line but are not on the calibration line, 
selecting the "Offset" option will improve the mean deviation.
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Quality (B)
> 94 % The quality is good.

90–94 % The quality is acceptable but could be improved. 
A better quality could produce a more accurate measurement. 

< 90 % The quality is not good.

Ways of improving the quality
– It is possible that the materials stated for the coating and substrate are poorly matched 

to the real materials. In this case, select "unknown" for the substrate and coating material.
– Repeat blank measurement, which was taken before initial commissioning. 

See Chapter 9.6.

SNR – signal to noise ratio (C)
> 20 A SNR value of less than 20 is very low and may produce unreliable measurements.

Ways of improving the SNR
– Position sample closer to the measurement aperture on the Layer Check. 

Do not position surface of sample any closer than 5 cm to the measurement aperture 
on the Layer Check.
Note: Changing the distance between the sample and measurement aperture also 
changes the measurement spot size.

– Increase light energy in the application. All existing reference measurements must 
be deleted before the light energy setting can be changed.

– If neither of these actions remedy the situation, use an optical reflex booster.
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7.5.3.1	 APPLICATION OFFSET

The correlation graph (D) can sometimes show systematic deviations between reference 
and Layer Check values. This can be seen with thin layers where all the calibration points 
are above the calibration line whereas with thick layers all the calibration points are below 
it (or vice versa). The following example clearly shows this situation:

P_03619

D

F

A

E

Meaning

F
Warning:
Little correlation with 
reference measurement.

Although the mean deviation (A) is below the 25 % limit and the calibration is therefore a 
success (E), a systematic deviation in the layer thickness value of the reference and Layer Check 
can be seen. In this case, permitting the offset for this application is appropriate. 
Select "Back" twice to return to the first page, select the "Offset (layer thickness) option" 
(see Chapter 7.5.1) and select "Next" twice.
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Once the offset has been activated, the correlation graph (D) shows a smaller mean deviation (A):

P_03620

A

G Meaning

G Shows the calibration offset 
(in this case 11.9 µm).

The offset allows systematic deviations between reference and Layer Check to be compensated. 
Such deviations may arise with rough or porous substrates/coatings in particular. At least 
four to eight reference measurements are needed to correctly determine the offset.
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7.6	 MEASURING BEFORE CURING

The Layer Check can be used to measure the layer thickness before curing without 
making contact with the coating (and therefore destroying it). This allows the Layer Check 
to be used to check processes and to measure process statistics. The Layer Check can 
be configured for this purpose such that it can predict the cured layer thickness using 
measurements taken before curing. The steps needed to create such an application are 
described in Chapter 7.6.3.

Depending on the type of coating (powder or liquid), different points must be considered 
for the measurement before curing (see Chapter 7.6.1 and/or 7.6.2).

7.6.1	 MEASURING POWDER LACQUERS BEFORE CURING

Powder coatings do not have an even thickness; instead the surface is wavy and the 
thickness may vary by several millimeters. This waviness is affected by various parameters, 
such as pretreatment, type and waviness of the base, lacquer type (e.g., grain size 
distribution and chemical composition). The waviness can still be seen after curing and 
depends on the curing conditions (temperature distribution, curing times).

P_03621

Waviness of a powder 
coating surface after 
curing
Area: 2 x 2 mm Differences 
in thickness: 15 µm

The measuring principle used by the person applying the lacquer may compensate for this 
waviness through optical averaging. The layer thickness can therefore be determined with 
reliability.

7.6.2	 MEASURING LIQUID COATINGS BEFORE CURING/DRYING

The thickness of the liquid coating is usually measured to determine the layer thickness 
after curing. This only produces reproducible results if the ratio of solvent to solids remains 
constant. With a liquid coating, the solvent evaporates so that the ratio changes over time. 
The reference measurements taken with the Layer Check should therefore be performed in the 
same coating state as the measurements the user intends to take later with the Layer Check.
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7.6.3	 CREATING APPLICATION FOR MEASUREMENTS BEFORE CURING

1. Produce reference parts, which are to be used for the Layer Check application. These 
parts should cover the range to be measured by the Layer Check, e.g., the tolerance 
range of the coating process. We recommend producing two parts with the minimum 
thickness for the measuring range and two with the maximum thickness.

2. Create new Layer Check application (see Chapter 7.5.1). Give this application a name, 
which indicates that the application is to be used for measurements in the process 
(e.g., "Liquid state"). Use the Layer Check to take, where possible, two reference 
measurements on each of the reference parts in different positions. After the reference 
measurement, click on "Save" without entering the reference values. Ensure that the 
positions of the reference measurements can be found again, e.g., by marking without 
destroying the coating at the measurement positions. This produces a total of eight 
reference measurements for the Layer Check application. Depending on the accuracy 
of the method used to measure the reference value, the number of measurements 
needed may vary.

3. Finish curing of the coating on the reference parts.
4. Use a reference process (e.g., microscopic cross-section analysis) to measure the layer 

thicknesses at the points marked on the reference parts. Enter the layer thicknesses 
measured in the "liquid" Layer Check application.

5. If possible and required, create a second new Layer Check application and add 
reference measurements for the cured reference parts using the same measurement 
positions. Give this application a name, which indicates that the application is only 
to be used on cured parts (e.g., "Cured state"). This application is only needed for 
periodically checking the functionality of the Layer Check on the reference parts.

6. Repeat the measurements at the positions marked on the reference parts with the 
"cured" Layer Check application. If the parts have been cut for a microscopic analysis, 
take the reference measurements close to the original position. Take a note of the 
layer thickness value for each measurement position. This value should be close to the 
value of the reference method, but does not have to match it exactly.
When the measurements are repeated on the reference parts, the Layer Check should 
always produce the same values.

7.7	 BACKING UP AND TRANSFERRING LAYER CHECK APPLICATIONS

The application data is stored in the Layer Check's embedded PC. If this PC fails or is destroyed, 
the work involved in creating the applications is lost. We therefore recommend producing 
a backup by exporting the Layer Check applications to an external storage device.
Applications can also be transferred between various Layer Check systems.
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7.7.1	 EXPORTING APPLICATION

1. File > Export

P_03622
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B

C

The window shown here appears.
2. Double-click on application (A).
3. Highlight "Export application" (B).
4. Next (C).

The next window appears.

5. Highlight the application to be 
exported (D).
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6. Click on the "…" button (E).
Define path and name of the 
export file.
Save.

7. Finish (F).
8. The export file is now stored 

under the path and name 
selected as a *.cmz file.
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7.7.2	 IMPORTING APPLICATION

1. File > Import
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The window shown here appears.
2. Double-click on application (A).
3. Highlight "Import application" (B).
4. Next (C).

The next window appears.

5. Click on the "…" button (D).
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E

Highlight the *.cmz file to be 
imported.
Open.

6. Finish (E).
7. The application file is now 

imported and added to the list 
of applications.
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7.8	 IMPORTING MATERIAL FILE

Material files contain settings for coating or carrier materials. Import material files as follows:

1. File > Import
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The window shown here appears.
2. Double-click on "Material" (A).
3. Highlight "Import material" (B).
4. Next (C).

The next window appears.

5. Click on the "…" button (D).
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E

Highlight the *.xml file to be 
imported.
Open.

6. Finish (E).
7. The settings for the selected 

material are now imported 
and are available to create an 
application.
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7.9	 EXPORTING MEASUREMENT DATA

Export measurement data for the active application:

1. File > Export
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B

C

Or in the main window 
(see Chapter 7.3) in the 
Application area: 

The window shown here appears.

2. Double-click on "Data" (A).
3. Highlight "Export data" (B).
4. Next (C).

The next window appears.
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EF

3. Use the filter settings for date and time (D) to select the time period for which the 
data is to be exported.

4. Update (E).
5. Export (F).

Define path and name of the export file. Save.
6. The export file is now stored under the path and name selected as a *.XML, CSV or 

QDAS file.
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8	 REMOTE CONTROL

This chapter describes how to operate the Layer Check with a device, which is connected 
to the Layer Check via the Ethernet. This may be e.g., a PLC (e.g., Siemens S7) or a PC with 
third-party software. The Layer Check desktop client uses a remote log to control the Layer Check.

The Layer Check is operated using commands, sent from the device to the Layer Check. 
The result of the command is sent back to the device from the Layer Check. The Layer Check 
acts as a server for the remote control. The device acts as a client.

Either a TCP/IP- or HTTP-based interface can be used to remotely control the Layer Check.

– Using TCP/IP interface: The commands and results for the TCP/IP interface are listed 
in Chapter 8.1.

– Using HTTP interface: The commands and results for the HTTP interface are listed in 
Chapter 8.2.

8.1	 TCP/IP

The commands and results are transferred as ASCII lines of text. As soon as a command 
has been processed, the TCP/IP connection is terminated from the Layer Check server, 
permitting access by other clients. The connection has to be re-established for the next 
command.

Important information for users of a Siemens SIMATIC S7 PLC
The Siemens S7 PLC is available in two different product types, which respond differently 
to an Ethernet connection – type PN/DP and type DP.

– Type PN/DP: With this type, the Ethernet is integrated in the CPU. The Ethernet connection 
is established and terminated automatically and requires no special commands in the 
software.

– Type DP: With this type, the Ethernet is not integrated in the CPU. The Ethernet connection 
must be established using software before every command and then terminated after 
every command.
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8.1.1	 GENERAL FORMAT OF COMMANDS AND RESULTS

A command line has the following format:
COMMAND?ARG1=VAL1&ARG2=VAL2&...CR/LF

Meaning of the elements in a command line:
COMMAND Name of the command 
? Separates a command from the arguments
ARGx Name of a command argument
VALx Value for the command argument
= Separator between command argument and value
& Separator between command arguments
<...> Place holder for dynamic values
----- Separating line
CR/LF Concludes the command 

(line break (Hex 0D 0A, escape sequence \r\n)).

The Layer Check responds to the commands with results in the following format:
RESULT?ARG1=VAL1&ARG2=VAL2&...CR/LF

Meaning of the elements in a result line
RESULT Name of the result
? Separates a command from the arguments
ARGx Name of a command argument
VALx Value for the command argument
= Separator between command argument and value
& Separator between command arguments
<...> Place holder for dynamic values
----- Separating line
CR/LF Concludes the command 

(line break (Hex 0D 0A, escape sequence \r\n)).

STATUS
The STATUS argument can be found in every command response and may adopt the following 
values:

Argument STATUS
Value Meaning
OK The command has been performed correctly.
ERROR The command has not been performed correctly and was 

aborted.
WARNING Warning, e.g., if the measured values are not reliable.
MESSAGE=<VAL> Description of problem in the event of an error or warning.
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8.1.2	 "MEASURE" COMMAND

The MEASURE command triggers a Layer Check measurement. An application must be selected 
for the measurement. This is stated by an ID and is the only argument for the MEASURE command.

Command Arguments Description
MEASURE CONFIGID Take measurement with the application with the ID specified by CONFIGID. 

The GETCONFIGURATIONS command can be used to call up the IDs of 
all applications saved on the Layer Check.

Application example
Command for triggering a measurement with the application ID no. 1:

MEASURE?CONFIGID=1<CR/LF>

Result Arguments Description
RES_MEASURE STATUS See Chapter 8.1.1.

MEASURE_ID Every measurement result contains a unique ID number (integer).
THICKNESS Layer thickness result (floating-point number)
TIMESTAMP Time stamp of measurement (integer). The value for this argument 

stands for "milliseconds since January 1 1970, 00:00:00 GMT".
Conversion of this time into desired time format: 
http://www.epochconverter.com/

Example of result
RES_MEASURE?STATUS=OK&MEASURE_ID=3&THICKNESS=12.0&TIMESTAMP=1362061773072<CR/LF>

In In this example, the measurement result is 12.0 μm and the value 1362061773072 stands 
for the time specification. February 28, 2013, 14:29:33 GMT.

Error and warning messages
Warning and error messages may be returned as the result of a MEASURE command. In this 
case, the result has the format:

RES_MEASURE?STATUS=ERROR&MESSAGE={error message}<CR/LF>
RES_MEASURE?STATUS=WARNING&MESSAGE={warning message}<CR/LF>

The text part in the curly brackets {...} contains a code for the warning or error:

Argument Values Description
MESSAGE 1 description of the error 1

2 description of the error 2
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8.1.3	 "GETCONFIGURATIONS" COMMAND

GETCONFIGURATIONS provides a list of all applications saved on the Layer Check. 
This command has no arguments.

Command Arguments Description
GETCONFIGURATIONS -- --

Application example
GETCONFIGURATIONS<CR/LF>

Result Arguments Description
RES_GETCONFIGURATIONS NAME Name, which the user has given the application.

ID Application ID for this application (integer)
… The NAME and ID are returned for every application saved 

on the Layer Check.

Example of result
RES_GETCONFIGURATIONS?STATUS=OK&ID=2&NAME=Lacquering1&ID=4&NAME=Lacquering2<CR/LF>

In this example, there are two applications saved on the Layer Check. The application with 
the name "Lacquering1" has the ID 2 and application with the name "Lacquering2" has the ID 4. 
IDs do not have to be sequential numbers.

8.1.4	 "GETCONFIGIDS" COMMAND

GETCONFIGIDS provides a list of the IDs of all applications saved on the Layer Check. 
This command has no arguments.

Command Arguments Description
GETCONFIGIDS -- --

Application example
GETCONFIGIDS<CR/LF>

Result Arguments Description
RES_GETCONFIGIDS STATUS See Chapter 8.1.1.

ID First application ID (integer)
… The ID is returned for every application saved on the 

Layer Check.

Example of result
RES_GETCONFIGIDS?STATUS=OK&ID=2&ID=3&ID=5<CR/LF>

In this example, there are three applications saved on the Layer Check. They have the IDs 2, 
3 and 5. IDs do not have to be sequential numbers.
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8.1.5	 "GETTHICKNESSBOUNDS" COMMAND

The GETTHICKNESSBOUNDS command provides a list of the warning and error limits for 
the layer thickness specified in an application. See Chapter 7.5.2.1 for more information 
about warning and error limits for the layer thickness.

Command Arguments Description
GETTHICKNESSBOUNDS CONFIGID ID of the application for which information about the 

layer thickness is being requested.

Application example
GETTHICKNESSBOUNDS?CONFIGID=1<CR/LF>

Result Arguments Description
RES_GETTHICKNESSBOUNDS STATUS See Chapter 8.1.1.

HAS_WARNING Boolean variable:
TRUE = A warning range is defined for the application.
FALSE = No warning range defined.
(See Chapter 7.5.2.1.)

WARNING_LOWER Lower layer thickness in micrometers for the warning range 
(integer). Only defined if the warning range is active.

WARNING_UPPER Upper layer thickness in micrometers for the warning range 
(integer). Only defined if the warning range is active.

HAS_ERROR Boolean variable:
TRUE = An error range is defined for the application.
FALSE = No error range defined.
(See Chapter 7.5.2.1.)

ERROR_LOWER Lower layer thickness in micrometers for the error range 
(integer). Only defined if the error range is active.

ERROR_UPPER Upper layer thickness in micrometers for the error range 
(integer). Only defined if the error range is active.

Example of result
RES_GETTHICKNESSBOUNDS?STATUS=OK&HAS_WARNING=true&WARNING_LOWER=50 
&WARNING_UPPER=60&HAS_ERROR=false&ERROR_LOWER=10&ERROR_UPPER=150<CR/LF>

In this example, the warning range is active while the error range is not active for the application. The lower 
limit for the warning range is 50 μm, the upper limit for the warning range is 60 μm. The values for the lower 
and upper limit of the error range are irrelevant.
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8.1.6	 "STARTAUTOMATION" COMMAND (AUTOMATIC MODE)

STARTAUTOMATION is intended for using the Layer Check desktop client's automatic mode. 
See Chapter 7.3.2.

8.1.7	 "STOPAUTOMATION" COMMAND (AUTOMATIC MODE)

STOPAUTOMATION is intended for using the Layer Check desktop client's automatic mode. 
See Chapter 7.3.2.

8.1.8	 "TRIGGERAUTOMATIONSENSOR" COMMAND (AUTOMATIC MODE)

TRIGGERAUTOMATIONSENSOR is intended for using the Layer Check desktop client's automatic 
mode. See Chapter 7.3.2.

8.1.9	 "GETAUTOMATIONSTATE" COMMAND (AUTOMATIC MODE)

GETAUTOMATIONSTATE is intended for using the Layer Check desktop client's automatic mode. 
See Chapter 7.3.2.

8.1.10	"CREATESAMPLE" COMMAND (AUTOMATIC MODE)

CREATESAMPLE is intended for using the Layer Check desktop client's automatic mode. 
See Chapter 7.3.2 (automatic mode) and Chapter 7.3.1 (blocks).

Command Arguments Description
CREATESAMPLE CONFIGID ID of the application for which a new block is to be generated.

Application example
CREATESAMPLE?CONFIGID=12<CR/LF>

Result Arguments Description
RES_CREATESAMPLE SAMPLE_ID ID of the newly created block (integer).

Example of result
RES_CREATESAMPLE?SAMPLE_ID=211<CR/LF>

The new block has the ID number 211. The block is automatically activated by the Layer Check 
client.

8.1.11	"GETNUMBEROFMEASUREMENTS" COMMAND

Command Arguments Description
GETNUMBEROFMEASUREMENTS

Result Arguments Description
RES_GETNUMBEROFMEASUREMENTS
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8.1.12	"GETSERVICESTATUS" COMMAND

Command Arguments Description
GETSERVICESTATUS

Result Arguments Description
RES_GETSERVICESTATUS

8.1.13	"GETCOATMASTERSTATUS" COMMAND

Command Arguments Description
GETCOATMASTERSTATUS STATUS Is the Layer Check ready? Command to check whether a 

measurement can be taken.
HAS_STARTUP Has a system start been run?
STARTUP_WAIT_
REMAINING

How long (ms) does the start take?

FLASH_READY Is the light source ready?
FLASH_WAIT_
REMAINING

How long (ms) does the charging process take?

READY Light source / start undertaken?
CURRENT_
ACTIVITY

"Measure": The device must not be moved.
"Evaluation": The device can be moved into a new position.
"None": The device is ready.

8.1.14	"GETOBJECTTEMPERATURE" COMMAND

Command Arguments Description
GETOBJECTTEMPERATURE CONFIG_ID ID of application

MEASURE_ID ID of measurement within the application

Application example
GETOBJECTTEMPERATURE?CONFIG_ID=2&MEASURE_ID=7<CR/LF>

Result Arguments Description
RES_GETOBJECTTEMPERATURE STATUS OK (if measurement is successful)

TEMPERATURE Measured temperature

8.1.15	"GETLASTOBJECTTEMPERATURE" COMMAND

Command Arguments Description
GETLASTOBJECTTEMPERATURE

Result Arguments Description
RES_
GETLASTOBJECTTEMPERATURE

STATUS OK (if measurement is successful)
TEMPERATURE Last measured temperature
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8.2	 HTTP

Triggering measurement
Request URI: http://{host:port}/measurementserver/measure?configID=/{Appl-ID}
Request method: POST
Request headers: {Accept=[application/json], Content-Length=[0]}

– {host:port} must be replaced by the TCP/IP address and port.
Example: http://192.168.1.100:1234/measurementserver/ etc.

– {Appl-ID} stands for the number of the application being used for the measurement.
The application IDs of all applications saved in the Layer Check are stored in the list 
of applications along with the application names.

Polling list of applications
Request URI: http://{host:port}/measurementserver/configurations
Request method: GET
Request headers: {Accept=[application/json], Content-Length=[0]}
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9	 MAINTENANCE

9.1	 MAINTENANCE PERSONNEL

Maintenance work should be undertaken regularly and carefully by qualified and trained 
personnel. They should be informed of specific hazards during their training.

The following hazards may arise during maintenance work:
− risk to health from inhaling solvent vapors,
− use of unsuitable tools and aids.

An authorized person must ensure that the device is checked for being in a reliable state 
after maintenance work is completed.

9.2	 SAFETY INSTRUCTIONS

WARNING
Electric shock!
Serious injury or death.

Before any maintenance work, switch the device off and disconnect the mains cable. 
Maintenance work may only be undertaken by authorized staff!

The Layer Check housing must not be opened even if the Layer Check is not connected 
to the mains. Exception: Unscrewing the rear cover to clean and/or change the filter mats 
(see Chapter 9.5). If the Layer Check is opened, the warranty is invalidated and all liability 
is declined.

Start up Layer Check at least every six months.
If the light source reaches 0 % or after one year since the last maintenance 
(even if the device has not been operating), the Layer Check must be maintained by 
the WAGNER Service Department.

The Layer Check desktop client monitors the spare Layer Check parts. As soon as the status 
of a spare part becomes critical or its intended operating life is reached / exceeded, a 
notification to this effect appears (see Chapter 7.3.4).
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9.3	 SOFTWARE MAINTENANCE

The Layer Check web client can be used to update the software on the Layer Check and 
the associated Layer Check desktop client. It can also be used to download log files for a 
detailed error analysis.

1. Ensure that the Layer Check and Windows PC are connected using an Ethernet cable.
2. Open a web browser. Enter the IP address of the Layer Check set in Chapter 6.7.1 

(e.g., "192.168.1.140") in the URL field and confirm with "Enter".
3. The web browser now connects to the Layer Check and opens the main window of 

the Layer Check web client.

P_03485
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4. Click on "Administrator" (B).
Log on as the user "admin" with the password "Welcome123".

9.3.1	 DIAGNOSIS

When resolving problems, the WAGNER Service Department will sometimes ask for the log 
files. To download the Layer Check log files, proceed as follows:

1. In the main window of the Layer Check web client (see Chapter 9.3):
Administrator > Diagnostic

P_03630

2. Download logs (ZIP)
Send log file to the WAGNER Service Department.
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9.3.2	 RESTORING SOFTWARE ON THE LAYER CHECK

To reverse a software upgrade, you can restore a previously installed version of the embedded 
software on the Layer Check.

1. In the main window of the Layer Check web client (see Chapter 9.3):
Administrator > System restore

P_03631

2. Select older software version and start the restore process.
3. After the restore process, restart the Layer Check.
4. Install the corresponding Layer Check desktop client (see Chapter 6.7.2).
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9.4	 MEASUREMENT WINDOW

Use compressed air free of oil to clean the measurement window of any dirt in order to 
ensure good performance and the reliability of the Layer Check.

Stubborn dirt can be removed using a soft, fluff-free cloth and alcohol (e.g., cloth for 
cleaning glasses).

9.5	 FILTER PADS

Perform regular visual checks on the filter mats. If the filter mats become dirty, they have 
to be cleaned. This involves the following steps:

1. Release two screws (A) on rear of device (see illustration).
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Rear view of 
Layer Check

2. Remove filter cover.
3. Remove filter mats and clean with compressed air.

If the filter mats become very dirty, they have to be replaced.
Order No., see Chapter 12.

4. Refit filter cover.
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9.6	 BLANK MEASUREMENT

After service work, the blank measurement has to be repeated.

1. Layer Check desktop client: Configuration > Settings > Device settings (A)
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2. The values for measurement duration, light energy, SNR threshold and decimal places 
are only defaults. The default values can be corrected in the application settings.
Measurement duration [ms] (B): Default value for the duration of the measurement
Light energy [J] (C): Default value for the energy of the light source.
SNR threshold (D): Default threshold value for the signal to noise ratio for detecting 
invalid measurements.
Decimal places (thickness) (E): Specification for the desired number of decimal places 
for displaying the thickness value.
Save raw data (F): Saves raw data during the measurement (for service purposes only). 
The Layer Check does not need the raw data for operations. We recommend deactivating 
this option.

3. Blank measurement (G): The "Start" button (H) opens a window with the request to 
cover the IR lens. Place WAGNER cover for blank measurements on IR lens. Click on 
OK to start the blank measurement. The blank measurement serves as a reference for 
subsequent sample measurements.
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10	 TROUBLESHOOTINGTROUBLESHOOTING

If a software error (error codes 1-14) appears, restart the device.

If the error persists, contact the WAGNER Service Department and provide the error code.

In the event of a hardware defect or malfunction (e.g., coolant leak), proceed as follows:
1. Immediately disconnect device from controller.
2. Inform the person responsible at the usage site of the fault.
3. Repair work may only be undertaken by authorized staff!

11	 DISPOSAL

NOTICE
Do not dispose of used electrical equipment with household refuse!
In accordance with European Directive 2012/19/EU on the disposal of used electrical 
equipment and its implementation in national law, this product may not be disposed of 
with the household refuse, but must be recycled in an environmentally correct manner.

WAGNER or one of our dealers will take back your used WAGNER electric or electronic 
equipment and will dispose of it for you in an environmentally-friendly way.
Please contact one of our service points, one of our representatives or us directly.
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12	 SPARE PARTS

DANGER
Incorrect maintenance/repair!
Danger to life and equipment damage.

Only a WAGNER service center or a suitably trained person may carry out repairs and 
replace parts.
Only repair and replace parts that are listed in the "Spare parts" chapter and that are 
assigned to the unit.
Before all work on the device and in the event of work interruptions:
− Relieve the pressure from the device.
− Secure the spray gun against actuation.
− Switch off the energy and compressed air supply.
− Disconnect the control unit from the mains.
Observe the operating and service manual for all work.

12.1	 HOW CAN SPARE PARTS BE ORDERED?

Always supply the following information to ensure delivery of the right spare part:
Order number, designation and quantity
The quantity need not be the same as the number given in the quantity column " " on 
the list. This number merely indicates how many of the respective parts are used in each 
component.

The following information is also required to ensure smooth processing of your order:
− address for the invoice,
− address for delivery,
− name of the person to be contacted in the event of any queries,
− Type of delivery (normal mail, express delivery, air freight, courier etc.)

Identification in spare parts lists
Explanation of column " " (labeling) in the following spare parts lists:

Wearing parts/ Wearing parts are not included in the warranty terms.
Included in service set
Not part of standard equipment, available, however, as additional extra.

Explanation of Order No. column:
-- Item not available as spare part. 
/ Position does not exist.

12.2	 FILTER PAD

Order no. Designation

1 2393373 1 Filter pad
Assembly: See Chapter 9.5

 Wearing parts
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13	 EU DECLARATION OF CONFORMITY

Herewith we declare that the supplied version of:

Layer Check LC 1000

complies with the following guidelines:

2014/30/EU
2014/35/EU

Applied standards, in particular:

EN 61010-1:2010
EN 61326-1:2013
EN ISO 9001: 2008

Identification:

EU Declaration of Conformity
The EU Declaration of Conformity is enclosed with this product. If needed, further copies 
can be ordered through your WAGNER dealer by specifying the product name and serial 
number.
Order number: 2395608





76

  

CERTIF
IE

D
 

ts-powder@wagner-group.com

www.wagner-group.com

Order no. 2395602
Edition 03/2018

D
oc

um
en

t N
o.

 1
12

18
19

0
Ve

rs
io

n 
-

http://www.wagner-group.com

